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Einleitung

Vorwort

Dieses Dokument beinhaltet die Unterlagen für das Praktikum Computeranimation und -Visua-
lisierung. Ab Kapitel 1 stellt jedes Kapitel einen Praktikumstermin mit dazugehörenden Übungs-
aufgaben dar.

Wir erwarten, dass Sie das jeweilige Kapitel vor dem Praktikumstermin zu Hause vorbereitet
haben. Am Praktikumstermin selbst bearbeiten Sie dann die Übungsaufgaben, die am Ende jedes
Kapitels stehen. Nur wenn Sie mit den Unterlagen vertraut sind, können Sie die Übungsaufgaben
in der vorgesehenen Zeit bearbeiten. Je besser Sie vorbereitet sind um so mehr werden sie von
diesem Praktikum profitieren. Stellt sich zu Begin des Praktikumtermins heraus, dass Sie sich
nicht vorbereitet haben, müssen Sie den Termin wiederholen.

Zur erfolgreichen Absolvierung des Praktikums müssen alle Praktikumstermine erfolgreich be-
arbeitet werden. Eine Bearbeitung der Übungsaufgaben zu Hause ist nicht möglich.

Wie diese Unterlagen zu lesen sind

Folgende Inhalte werden in diesen Unterlagen zur besseren Kennzeichnung besonders darge-
stellt:

Befehle und Funktionen aus Anwendungen: Datei→Öffnen

Dateinamen und Pfade: C:\Programme
Tasten oder Tastenkombinationen: Shift-Taste

Geschützte Namen und Eigennamen: discreet 3ds max

Fachbegriffe und Erklärung von Abkürzungen: Szenengraph

Abbildungen die z.B. mehrere Icons enthalten werden, wenn nicht anders angegeben, zeilen-
weise von links nach rechts und von oben nach unten durchnummeriert.

Quellcode:

Group {
children [

Cylinder {
}

]
}
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Einleitung 3

Empfohlene Literatur

Zu Begin jedes Kapitels finden Sie eine Angabe von theoretischem Wissen, welches Sie benötigen,
um die jeweiligen Übungsaufgaben sinnvoll bearbeiten zu können. Je besser Sie an dieser Stelle
vorbereitet sind, desto größer wird der Lerneffekt im Praktikum sein.

Dieses Wissen erhalten Sie durch den Besuch der Vorlesung und die Lektüre der dazu gehörigen
Vorlesungsunterlagen. Zusätzlich dazu sind folgende Bücher zu empfehlen (nähere Informatio-
nen zu den Büchern finden Sie im Anhang):

Computergrafik. Ein anwendungsorientiertes Lehrbuch [BB03] Auf diesem Buch basiert die
Vorlesung zu diesem Praktikum.

3D Computer Graphics [Wat99] Ein oft zitiertes Standardwerk, dass alle Themen der Com-
putergrafik, die Sie für dieses Praktikum brauchen, behandelt. Auch in der deutschen Über-
setzung erschienen [Wat01].

Computer Graphics using OpenGL [Hil01] Ein gelungenes Buch zur Computergrafik, mit
Betonung auf OpenGL.

Computer Graphics: A Visual Approach [Wol00] Ein überraschend dünnes Buch, dass einen
recht guten, wobei auch kurzen Überblick über die Themen dieses Praktikums liefert. Wer
mehr in die Tiefe gehen will ist mit [Wat99] oder [FDFH91] besser bedient.

Computer Graphics - Principles and Practice [FDFH91] Ein Nachschlagewerk mit viel Tief-
gang. Für den Fall, dass Sie etwas sehr genau und detailliert wissen wollen.

Mathematik für Informatiker [Bri01] Was Sie für dieses Praktikum an Mathematik benöti-
gen finden Sie in diesem Buch.

Tip:
In der Bibliothek des Standorts Zweibrücken finden Sie Bücher zum Thema Compu-
tergrafik unter der Signatur I800. Bücher speziell zu 3ds max finden Sie unter I851,
zu Maya unter I852.

Das Labor

Das gesamte Praktikum findet im Visualisierungslabor des Standorts Zweibrücken, dem sog. Vis-
Lab (Raum O-210) statt. Das VisLab verfügt über 10 Arbeitsplatzrechner mit folgender Ausstat-
tung: Athlon XP 1600+, 768 MB RAM, GeForce3 Grafikkarte. Die Rechner laufen unter Windows XP
Professional und gehören zur Domäne DS des Standorts Zweibrücken. Sie benötigen also kein
zusätzliches Login und haben auch Zugriff auf ihr Verzeichnis auf dem Studenten-Fileserver.

Folgende Richtlinien sind im VisLab zu beachten:

Essen, trinken und rauchen ist im VisLab untersagt.

An jedem Rechner arbeiten zwei Studierende. Sollten bei einem Termin noch Rechner frei
sein oder ein Student übrig bleiben, kann auch alleine an einem Rechner gearbeitet werden.
Dreier-Teams sind nicht erlaubt.

Die Rechner bleiben immer angeschaltet, schalten Sie jedoch die Monitore nach dem Prakti-
kumstermin aus.
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Server und Verzeichnisse

Während dem Praktikum arbeiten Sie meist lokal auf den Rechnern im VisLab. Außerdem hat
das VisLab einen eigenen Server für den Lehrbetrieb (zwo210-gauss).

Sie arbeiten in Laufe des Praktikums immer mit folgenden Verzeichnissen:

Aufgabenstellung
Es kann vorkommen, dass Sie zur Bearbeitung der Aufgaben bestimmte Dateien benötigen
(Details hierzu entnehmen Sie der jeweiligen Aufgabenstellung). Diese Daten finden Sie im-
mer unter:

\\zwo210-gauss\public\cav\...\Aufgabenstellung
Lokales Laufwerk
Während des Praktikumtermins sollten Sie lokal auf dem Rechner arbeiten, an dem Sie ge-
rade sitzen. Hierzu steht Ihnen das Laufwerk D: zur Verfügung (schreiben Sie keine Daten
in Laufwerk C: !). Am Ende des Termins verschieben Sie alle ihren Daten in Ihr Homever-
zeichnis (mehr dazu weiter unten). Stellen Sie sicher, dass das lokale Laufwerk D: leer ist,
wenn Sie den Rechner verlassen!

Home-Verzeichnis
Zu Beginn jedes Semesters wird für jeden Praktikumsteilnehmer ein sog. Home-Verzeichnis

auf zwo210-gauss angelegt. In diesem Verzeichnis sollen Sie am Ende des Praktikumter-
mins alle Daten ablegen, die während dem Praktikum entstanden sind. Ihnen stehen dazu
100 MB zur Verfügung. Speichern Sie keine privaten Daten oder Daten anderer Lehrveran-
staltungen in dieses Verzeichnis ab! Sie finden Ihr Homeverzeichnis unter:

\\zwo210-gauss\Ihrem Login in der Domäne DS

Abgabe
Am Ende jedes Praktikumtermins müssen Sie in der Regel etwas abgeben. Damit sind nicht
alle Daten gemeint, die Sie während des Praktikums erzeugt haben (dafür haben Sie Ihr
Home-Verzeichnis), sondern meist nur die Endergebnisse (Details hierzu entnehmen Sie
der jeweiligen Aufgabenstellung). Dieses Verzeichnis hierzu finden Sie unter:

\\zwo210-gauss\public\cav\...\Abgabe
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Kapitel 1

Einführung in moderne
Modellierungswerkzeuge

1.1 Lernziele

Nach dieser Übung sind Sie mit der grundlegenden Bedienung von drei im Praktikum einge-
setzten Modellierungswerkzeugen vertraut. Dies ist sehr wichtig, da Sie in späteren Übungen
mit diesen Werkzeugen konkrete Aufgaben bearbeiten werden und Sie dann mit den Grund-
funktionen der einzelnen Werkzeuge vertraut sein müssen.

1.2 Werkzeuge dieser Übung

discreet 3ds max - Im Praktikum im Wintersemester 2003/2004 verwenden wir die Version
5.1 . Weitere Informationen finden Sie unter der URL des Herstellers:

http://www.discreet.com

Für das praktische Üben zu Hause empfehlen wir Ihnen gmax. Hierbei handelt es sich um
eine freie, im Funktionsumfang eingeschränkte Version von 3ds max. Zwar können Sie mit
ihr keine Bilder rendern, trotzdem sind alle grundlegenden Funktionen vorhanden und das
Interface ist mit dem von 3ds max identisch. Sie können gmax unter folgender URL herun-
terladen:

http://www.discreet.com/products/gmax/

AliasWavefront Maya - Im Praktikum im Wintersemester 2003/2004 verwenden wir Maya
Complete,Version 5.Weitere Informationen finden Sie unter der URL des Herstellers:

www.aliaswavefront.com

Für das praktische Üben zu Hause empfehlen wir Ihnen die Maya Personal Learning Edition.
Hierbei handelt es sich um eine freie, im Funktionsumfang eingeschränkte Version von Maya.
Sie können die Maya PLE unter folgender URL herunterladen:

http://www.alias.com/eng/products-services/maya/maya ple/index.shtml/

Rhinoceros - Im Praktikum im Wintersemester 2003/2004 verwenden wir die Version 2.0.
Weitere Informationen finden Sie unter der URL des Herstellers:
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1 Einführung in moderne Modellierungswerkzeuge 6

www.Rhino3d.com

Für das praktische Üben zu Hause empfehlen wir Ihnen die Rhino Evaluation. Hierbei han-
delt es sich um eine freie, voll funktionsfähige Version von Rhino. Einzige Einschränkung ist,
dass Sie nur 25 mal speichern können. Danach bleibt sie aber weiterhin funktionsfähig. Sie
können die Rhino Evaluation unter folgender URL herunterladen:

http://download.mcneel.com/rhino/3.0/eval/

Sollten Sie über keinen schnellen Internetzugang verfügen, können Sie die Werkzeuge auch im
Praktikum auf CD zum Kopieren ausleihen. Generell wird für 3D-Grafikwerkzeuge eine 3-Tasten-
Maus empfohlen. Viele Funktionen, die das Arbeiten enorm erleichtern können, nutzen eine mitt-
lere Maustaste.

1.3 Vorausgesetztes Wissen

Für die erste Übung benötigen Sie nur wenig theoretisches Vorwissen. Trotzdem sollten Ihnen
folgendes bekannt sein:

Sicherheit im Umgang mit Microsoft Windows XP.

Sicherheit und Erfahrung im Bedienen von Windows -Applikationen.

Was ist ein Koordinatensystem?

Was sind Transformationen?

Was bedeutet der Begriff ”Rendern“?

Praktikum Computeranimation und -Visualisierung
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1.4 Einführung in 3ds max

3ds max ist ein vollständiges Modellierungs- und Animationswerkzeug und gehört zu den führen-
den Anwendungen in diesem Sektor. 3ds max ist nur für Windows (NT, 2K, XP) verfügbar.

Wenn sie 3ds max im VisLab starten und beenden erscheinen einige Fehlermeldungen, da Sie
kein uneingeschränktes Schreibrecht auf den VisLab-Rechnern haben. Sie können diese Meldun-
gen einfach ignorieren.

1
2

3

4 5

6

Abbildung 1.1: Die Benutzeroberfläche von 3ds max

1 Menu Bar
2 Main Toolbar
3 Tab Panel (wird mit der y-Taste ein-/ und ausgeblendet)
4 Viewports
5 Command Panels
6 Viewport navigation controls

1.4.1 Besonderheiten von 3ds max

Bei 3ds max können sich hinter einem Icon weitere Icons verbergen; man spricht von flyouts.
Diese Icons sind mit einem kleinen, schwarzen Dreieck am rechten unteren Rand des Icons
gekennzeichnet. Wenn sie ein solches Icon mit der linken Maustaste anklicken und diese hal-
ten,erscheinen weitere Icons für ähnliche Funktionen wie die das Icons. Ein Beispiel hierfür sehen
sie in Abbildung 1.2.
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1 Einführung in moderne Modellierungswerkzeuge 8

Abbildung 1.2: Beispiel für ein Flyout-Icon

1.4.2 Szenen in 3ds max

Eine Datei, die Sie in einem Modellierungswerkzeug erstellt haben nennt man in der Regel Szene
oder scene. Wenn Sie in 3ds max ein Objekt erstellt haben und dies abspeichern, speichern Sie
nicht nur das Objekt, sondern die ganze Szene ab (im .max-Format). Eine solche Szene enthält
die ”Welt“ in der sich die Objekte befinden, Materialien, Lichtquellen, Kameras, Animationen
usw. Alle diese Dinge werden sie im weiteren Verlauf dieses Praktikums noch kennen lernen. Im
Gegensatz dazu enthalten einige Teile einer Szene nur Verknüpfungen zu Dateien, die nicht mit
der Szene abgespeichert werden (z.B. Texturen), dazu aber später mehr.

Es ist auch möglich ein einzelnes Objekt abzuspeichern bzw. zu laden, dies ist meist nötig um
ein Objekt in einem anderen Modellierungswerkzeug weiter zu bearbeiten. Hier spricht man von
Import bzw. Export. 3ds max bietet hierzu eine ganze Reihe von verschiedenen Dateiformaten an.
Oft müssen die hierzu benötigten Import- bzw. Export-Filter aber erst als Plug-in geladen werden
(Menu Bar→Customize→Plug-in Manager. . . ).

1.4.3 Viewports in 3ds max

Standardeinstellung beim Start sind vier gleichgroße Viewports. Die Fenster lassen sich mit der
Maus durch ”Ziehen“ verändern. Vordefinierte Layouts finden Sie unter: Menu Bar→Customize
→Viewport Configuration. . .→Layout .

Um einen einzelnen Viewport zu verändern, klicken Sie mit der rechten Maustaste auf die Be-
zeichnung des Viewports (z.B. Top). Im erscheinenden Menü können Sie dann die gewünschte
Darstellungsform (Smooth oder Wireframe) und unter Views eine andere Sicht wählen. Um einen
Viewport zu aktivieren, klicken Sie einfach mit der linken Maustaste hinein. Der aktive Viewport
wird farbig umrandet.

1.4.4 Die Command Panels von 3ds max

Sie können unter 6 Panels wählen, die nach Aufgabengebieten sortiert sind. Sehen Sie hierzu
Abbildung 1.3.

1.4.5 Viewport navigation controls/Camera Viewport Controls in 3ds max

Hier finden Sie Funktionen um in den einzelnen Viewports zu navigieren (siehe Abbildung 1.4).
Alle Veränderungen die Sie hier tätigen verändern nur die Sicht in den Viewports und nicht die
einzelnen Objekte!

Stellt der aktive Viewport eine Kamerasicht dar, dann verschwinden einige Icons und an deren
Stelle erscheinen die Camera Viewport Controls (siehe Abbildung 1.5).
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Abbildung 1.3: Die 6 Command Panels von 3ds max

1 Create panel - Zum Erzeugen von Objekten
2 Modify panel - Zum Modifizieren von erzeugten Objekten
3 Hierarchy panel - Hierarchien und Kinematik
4 Motion panel - Animation
5 Display panel - Bildschirmanzeige
6 Utilities panel - Spezielle Funktionen und Plug-Ins

Abbildung 1.4: Die Viewport Navigation Controls von 3ds max

1 Zoom – Um in den aktiven Viewport hinein bzw. hinaus zu zoomen.
2 Zoom All – Um in alle Viewports hinein bzw. hinaus zu zoomen.
3 Zoom Extents – Um alle Objekte im aktiven Viewport anzuzeigen.
4 Zoom Extents All – Um alle Objekte in allen Viewports anzuzeigen.
5 Region Zoom – Um in eine ausgewählte Region hinein zu zoomen.
6 Pan – Um die Ansicht zu verschieben.
7 Arc Rotate – Um die Ansicht zu rotieren.
8 Min/Max Toggle – Um den aktiven Viewport zu vergrößern bzw. zu verkleinern.

Abbildung 1.5: Die Camera Viewport Controls von 3ds max

1 Dolly Camera – Um die Kamera entlang der Sichtlinie zum bewegen.
2 Perspective – Um die Kameraperspektive zu verändern.
3 Roll Camera – Um die Kamera entlang der Sichtlinie zu rotieren.
4 Field of View – Um den Blickwinkel der Kamera zu verändern.
5 Truck Camera – Um die Kamera seitlich bzw. nach oben und unten zu bewegen.
6 Orbit Camera – Um die Kamera um ein Objekt zu bewegen.

1.4.6 Die Maussteuerung von 3ds max

Die drei wichtigsten Funktionen zur Navigation in den Viewports lassen sich auch schnell mit
der Maus aufrufen:

Pan – Strg-Taste und mittlere Maustaste

Arc Rotate – Alt-Taste und mittlere Maustaste

Zoom – Strg-Taste und Alt-Taste und mittlere Maustaste
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1.4.7 Einfache Objekte erstellen in 3ds max

Es gibt in 3ds max mehrere Wege Objekte zu erstellen:

Menu Bar→Create

Command Panel → Create

Tab Panel → Objects

Hat man den Objekttyp gewählt, den man erzeugen möchte, kann man das Objekt auf zwei Arten
erzeugen:

Mit der Maus
Klicken Sie mit der linken Maustaste in einen Viewport, halten Sie die linke Maustaste und

”ziehen“ sie das Objekt auf. Hat das Objekt mehrere Parameter, werden diese nach dem Los-
lassen der Maustaste eingestellt.

Mit der Tastatur
Nach dem Auswählen des gewünschten Objekts erscheint im Create Panel der Rollout Key-
board Entry . Hier können Sie die Objektparameter mit der Tastatur eingeben. Nach dem Klicken
auf Create wird das Objekt erzeugt.

1.4.8 Objekte auswählen und Parameter verändern in 3ds max

Abbildung 1.6: Objekte auswählen in 3ds max

1 Select - Um ein Objekt auszuwählen mit der linken Maustaste auszuwählen.
Mit Hilfe der Strg-Taste können so auch mehrere Objekte nacheinander aus-
gewählt werden. Sie können auch eine Auswahlregion um mehrere Objekte
ziehen.

2 Select by Name - Bei sehr vielen Objekten sollten Sie diese Funktion zu Hilfe
nehmen. Diese gibt ihnen eine Auflistung aller Objekte in der Szene.

3 Selection Region - Hier können Sie einstellen, welche Form die Auswahlregion
(siehe Select) hat.

Um die Objektparameter zu verändert, müssen Sie zu Command Panel→Modify wechseln. Dort
finden Sie dann ganz oben ein Eingabefeld für den Objektnamen und die Farbe, mit der das
Objekt dargestellt wird. Weiter unten finden Sie das Rollout Parameter .

Um ein Objekt zu löschen, wählen Sie es an und drücken die Entf-Taste.

1.4.9 Transformationen in 3ds max

Im Main Toolbar findet man folgende Icons zu den 3 Transformationen Translation, Rotation und
Skalierung:

Wenn Sie eine Transformation ausgewählt haben, können Sie die gewünschten Werte nach Drücken
der F12 auch per Tastatur eingeben. Alternativ können die Transformationen auch über das Quad
Menu (Rechtsklick auf ein Objekt) oder mit den Hotkeys w , e und r aufgerufen werden.
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Abbildung 1.7: Die Transformationen Move, Rotate und Scale in 3ds max

1 Move - Mit Hilfe der auftauchenden Handles lässt sich das Objekt in die
gewünschte Richtung verschieben. Auch die Kombination zweier Richtungen
ist möglich.

2 Rotate - Mit Hilfe der auftauchenden Handles lässt sich das Objekt um die
gewünschte Achse rotieren.

3 Scale - Mit Hilfe der auftauchenden Handles lässt sich das Objekt entlang
der gewünschte Achse skalieren. Auch die Kombination zweier Achsen ist
möglich. Das Zentrum der Handles dient zur gleichförmigen Skalierung an-
hand aller 3 Achsen.

1.4.10 Snaps in 3ds max

Zum Transformieren von Objekten bietet ihnen 3ds max praktische Hilfen, die sog. Snaps an.
Diese können Sie jeweils einzeln an- und ausschalten.

Abbildung 1.8: Snaps in 3ds max

1 2D/2.5D/3D Snap - Erleichtert das Ausrichten von Objekten am eingestellten
Grundraster, indem es immer bei ganzen Werten ”einrastet“.

2 Angle Snap - Erleichtert das Rotieren von Objekten, indem es nur um einen
bestimmten Wert rotiert.

3 Percent Snap - Erleichtert das Arbeiten mit Prozentzahlen (z.B. beim
gleichförmigen Skalieren, da es nur das Erhöhen/Erniedrigen in frei wähl-
baren Schritten zulässt).

4 Spinner Snap - Erleichtert das Arbeiten mit den sog. Spinnern (z. B. in den
Comand Panels), da es hier nur ganze Werte zulässt.

Wie groß diese Raster und Werte sind und weitere Einstellungen finden Sie unter Menu Bar→
Customize→Grid and Snap Settings. . . oder durch einen Rechtsklick auf das jeweilige Icon.

1.4.11 Objekte ausrichten, spiegeln und kopieren in 3ds max

Abbildung 1.9: Align und Mirror von 3ds max

Um Objekte aneinander auszurichten, wählen Sie zunächst das Objekt, das ausgerichtet werden
soll und klicken dann auf das Icon Align. Danach wählen Sie das Objekt aus, an dem Sie ausrichten
wollen. Darauf hin öffnet sich das Align-Fenster.

Unter Abbildung 1.11 sehen sie ein Beispiel für das Arbeiten mit Align. Ein Würfel soll genau
bündig und zentriert auf einem Quader sitzen. Mit der Funktion Align ist dies schnell und exakt
möglich.
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Abbildung 1.10: Das Align-Fenster von 3ds max

Abbildung 1.11: Ein Beispiel für die Funktion Align

Mit der Funktion Mirror können Sie ein Objekt spiegeln, d.h ein spiegelverkehrte Kopie des Ob-
jekts erstellen. Beachten Sie dabei, das Sie mit Offset die Entfernung angeben, die das neue Ob-
jekte zum Ausgangsobjekt hat (gemessen von der Objektmitte).

Wenn Sie ein Objekt mit der Maus verschieben und dabei die Shift-Taste gedrückt halten können
Sie Kopien des Objekts erstellen.
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1.4.12 Der Modifier Stack von 3ds max

Mit dem Erzeugen eines Objekts legt 3ds max einen sog. Modifier Stack für das Objekt an. In die-
sem werden die Erstellungsparameter und alle auf das Objekt angewandte Modifier gespeichert
(Modifier lassen wir in diesem Praktikum außer Acht, mehr dazu später). Die Reihenfolge im
Stack entspricht von unten nach oben der Reihenfolge, wie die Modifikationen getätigt wurden.
Ganz unten steht der Objekttyp mit den Erstellungsparameter. Sie können einzelne Modifika-
tionen herauslöschen oder nachträglich verändern. Sie finden den Modifier Stack ganz oben im
Modify panel.

3

1
2

4
Abbildung 1.12: Modifier Stack von 3ds max

1 Modifier List - Eine Liste der Modifikatoren, die auf das Objekt angewendet
werden können.

2 Modifier Stack - Die Modifikatoren, die bisher auf das Objekt angewandt wur-
den, Reihenfolge von unten nach oben.

3 Show end result - Um das Endergebnis aller Modifikatoren zusammen anzu-
zeigen.

4 Remove modifier from the stack - Löscht den ausgewählten Modifikator aus dem
Stack.

1.4.13 Rendern in 3ds max

Um ein zweidimensionales Bild von einer Szene zu erzeugen benötigen Sie die Funktion Ren-
dern (oder auch Bildsynthese). Auf das Thema Rendern wird im späteren Verlauf des Praktikums
noch weiter eingegangen. Um ein Bild von einer Szene zu rendern wählen Sie eine der folgenden
Funktionen:

Menu Bar→Rendering→Render. . .

Main Toolbar→Render Scene

Abbildung 1.13: Rendern in 3ds max
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Tab Panel→Rendering→Render Scene

F10-Taste

Im erscheinenden Render-Window können Sie unter anderem folgende Einstellungen vorneh-
men:

1

2

3

4

5 6
Abbildung 1.14: Das Render -Window in 3ds max

1 Time Output - geben Sie an, ob Sie nur ein Bild/Frame (Single) oder eine Ani-
mation (mehrere Frames) ausgeben wollen.

2 Output Size - Die Größe der ausgegebenen Frames in Pixel.
3 Render Output - Hier stellen Sie ein, ob das Bild im Arbeitsspeicher (Virtual Fra-

me Buffer) erzeugt wird oder ob Sie die Ausgabe direkt in eine Datei erzeugen
wollen. Das Format und die Dateiablage geben sie unter Files. . . an.

4 Renderer - Hier können sie die Rendermethode auswählen. Im Zweifelsfall
lassen Sie hier die Standardeinstellung.

5 Viewport - Hier geben Sie an, welchen Viewport (also welche Ansicht der Sze-
ne) sie rendern möchten.

6 Render - Hier starten Sie den Render-Prozess.
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1 Einführung in moderne Modellierungswerkzeuge 15

1.5 Einführung in Maya

Maya ist ein vollständiges Modellierungs- und Animationswerkzeug und gehört zu den führen-
den Anwendungen in diesem Sektor. Maya ist für folgende Plattformen verfügbar: Windows
(NT, 2K, XP), LINUX, IRIX.

1
2

3

4 6

5

Abbildung 1.15: Die Benutzeroberfläche von Maya

1 Menu Bar
2 Status Line
3 Shelf
4 Toolbox
5 Viewports
6 Attribute Editor bzw. Tool Settings bzw. Channel Box / Layer Editor

1.5.1 Besonderheiten von Maya

Beim Auswählen von Funktionen über den Menu Bar taucht oft das unter Abbildung 1.16 gezeigte
Icon auf:

Abbildung 1.16: Die Options - Funktion in Maya

Wenn Sie dieses Icon auswählen, wird die Funktion nicht direkt ausgeführt, sondern Sie können
zunächst Parameter mit der Tastatur eingegeben. Diese Funktion wird im weiteren mit dem Icon
� dargestellt.
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1.5.2 Szenen und Projekte in Maya

Wie 3ds max arbeitet auch Maya mit Szenen. Allerdings ist in Maya eine Szene immer Teil ei-
nes Projekts. Ein Projekt ist ein Verzeichnis mit einer festen Orderstruktur. Wenn Sie kein eigenes
Projekte anlegen erzeugt Maya standardmäßig ein Projekt names default unter ...\Eigene
Dateien\maya\projects\. Zu Beginn sind zunächst der Ordner scenes für die Szenen, so-
wie der Ordner images für die gerenderten Bilder für Sie relevant.

Diese strenge Verwaltung der Dateien hat einige Vorteile. So einen findet sich der Benutzer auch
bei Szenen die er nicht selbst erstellt hat schnell zurecht. Wie Sie schon gehört haben, kann ei-
ne Szene auch Verknüpfungen zu Dateien enthalten. Dies hat den Nachteil, dass wenn man die
verknüpften Dateien verschiebt, die Verknüpfung nicht mehr stimmt und Texturen beim Ren-
dern beispielsweise nicht mehr gefunden werden. Die Verwaltung der Dateien in Projekten mit
festgelegten Ordnern beispielsweise für die Texturen soll dies unterbinden.

Natürlich bietet auch Maya den Import bzw. Export von Objekten in verschiedene Dateiforma-
te an. Oft müssen die hierzu benötigten Import- bzw. Export-Filter aber erst als Plug-in geladen
werden (Menu Bar→Window→Settings/Preferences→Plug-in Manager. . . ).

1.5.3 Der Menu Bar von Maya

Direkt am Anfang der Status Line finden Sie ein Pull-Down Menü, mit dem sich der Menu Bar an
die jeweiligen Aufgabenbereiche anpassen lässt. Diese Bereiche sind:

Animation

Modeling

Dynamics

Rendering

Viele Funktionen aus der Status Line stehen Ihnen im Shelf auch in Form von Icons zur Verfügung.

1.5.4 Die Status Line Bar von Maya

Neben dem eben erwähnten Pull-Down Menü finden Sie am Ende der Status Line drei Icons, mit
denen Sie den Attribute Editor , die Tool Settings und die Channel Box einblenden können.

Abbildung 1.17: Attribute Editor , Tool Settings und Channel Box in Maya

1.5.5 Viewports in Maya

Standardeinstellung beim Start ist ein Viewport mit einer räumlichen Ansicht wie unter Abbil-
dung 1.15 gezeigt. Im unteren Teil der Toolbox finden Sie weitere vordefinierte Layouts (siehe
Abblildung 1.18).

Um einen einzelnen Viewport zu verändern, finden Sie an seiner oberen Kante weitere Einstel-
lungsmöglichkeiten wie die gewünschte Darstellungsform (Smooth oder Wireframe) unter Shading
oder vordefinierte Views (View→Predefined Bookmarks). Um einen Viewport zu aktivieren, klicken
Sie einfach hinein. Der aktive Viewport wird farbig umrandet.
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Abbildung 1.18: Drei nützliche vordefinierte Layouts von Maya: Perspektivische Ansicht, Vier Ansichten,
Perspektivisch mit Outliner

1.5.6 Die Maussteuerung von Maya

Die drei wichtigsten Funktionen zur Navigation in den Viewports lassen sich mit der Maus auf-
rufen. Beachten Sie, dass alle Veränderungen die Sie hier tätigen nur die Sicht in den Viewports
und nicht die einzelnen Objekte verändern!

Pan – Alt-Taste und mittlere Maustaste

Arc Rotate – Alt-Taste und linke Maustaste

Zoom – Alt-und linke und mittlere Maustaste

1.5.7 Einfache Objekte erstellen in Maya

Um ein Objekt zu erzeugen, wählen Sie über Menu Bar →Create oder über das Shelf das gewünsch-
te Objekt aus. Das Objekt wird direkt mit Default-Parametern im Ursprung der Szene erstellt. Mit
dem �-Icon können Sie, wenn gewünscht, zuvor Parameter angeben.

1.5.8 Objekte auswählen und Parameter verändern in Maya

Um ein Objekt auszuwählen, aktivieren Sie die Funktion Select und klicken Sie dann auf das
gewünschte Objekt. Mit Hilfe der Shift-Taste können so nacheinander auch mehrere Objekte aus-
gewählt werden. Sie können auch eine Auswahlregion in Form eines Rechtecks um mehrere
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Abbildung 1.19: Auswahlwerkzeuge in Maya

Objekte ziehen. Mit dem Lasso Tool können ebenfalls mehrere Objekte auf einmal ausgewählt
werden.

Bei sehr vielen Objekten sollten Sie den Outliner zu Hilfe nehmen. Sie finden ihn unter Menu
Bar→Window oder sie nutzen das vordefinerte Viewport-Layout (siehe Abbildung 1.18). Dieser
gibt ihnen eine Auflistung aller Objekte in der Szene.

Um die Objektparameter zu verändern, müssen Sie über die Status Line oder durch die Tasten-
kombination Strg-A zum Attribute Editor wechseln.

Um ein Objekt zu löschen, wählen Sie es an und drücken die Entf-Taste.

1.5.9 Transformationen in Maya

In der Tool Box findet man folgende Icons zu den 3 Transformationen Translation, Rotation und
Skalierung:

Abbildung 1.20: Die Transformationen Move, Rotate und Scale in Maya

1 Move - Mit Hilfe der auftauchenden Handles lässt sich das Objekt in die
gewünschte Richtung verschieben. Auch die Kombination zweier Richtungen
ist möglich.

2 Rotate - Mit Hilfe der auftauchenden Handles lässt sich das Objekt um die
gewünschte Achse rotieren.

3 Scale - Mit Hilfe der auftauchenden Handles lässt sich das Objekt entlang
der gewünschte Achse skalieren. Auch die Kombination zweier Achsen ist
möglich. Das Zentrum der Handles dient zur gleichförmigen Skalierung an-
hand aller 3 Achsen.

Alternativ können Sie die Transformationen auch mit den Hotkeys w , e und r aufrufen. Wenn
sie ein Objekt ausgewählt haben, können Sie die exakten Werte auch per Tastatur in der Channel
Box eingeben.

1.5.10 Snaps in Maya

Zum Transformieren von Objekten bietet Ihnen Maya praktische Hilfen, die sog. Snaps an. Diese
können Sie jeweils einzeln an- und ausschalten.

Wie groß das Grundraster (Grid) ist und weitere Einstellungen finden Sie unter Menu Bar → Display
→ Grid �.
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Abbildung 1.21: Snaps in Maya

1 Snap to grids - Erleichtert das Ausrichten von Objekten am eingestellten
Grundraster, indem es immer bei ganzen Werten ”einrastet“.

2 Snap to curves - Erleichtert das Ausrichten von Objekten an einer Kurve.
3 Snap to points - Erleichtert das Ausrichten von Objekten an bestimmten Punk-

ten.
4 Snap to view planes - Erleichtert das Ausrichten von Objekten an einer View-

plane.

1.5.11 Objekte ausrichten und kopieren in Maya

Um Objekte aneinander auszurichten, wählen Sie zunächst die Objekte, die zueinander aus-
gerichtet werden sollen mit Hilfe der Shift-Taste aus (zuerst das Objekt, das ausgerichtet wer-
den soll, dann das Objekt, an dem ausgerichtet werden soll) und klicken Sie dann auf Menu
Bar→Modify→Snap Align Objects→Align Tool. Um die Objekte erscheinen nun mehrere Symbole,
mit denen Sie ganz intuitiv die Objekte ausrichten können. Unter Abbildung 1.22 sehen sie ein
Beispiel für das Arbeiten mit Align. Wieder soll ein Würfel genau bündig und zentriert auf einem
Quader sitzen. Mit der Funktion Align ist dies wieder schnell, einfach und exakt möglich.

Abbildung 1.22: Die Funktion Align in Maya

Um ein Objekt zu kopieren, wählen Sie es an und wählen Menu Bar→Edit→Duplicate. Hierbei liegt
die Kopie allerdings genau über dem Originalobjekt. Wenn sie die Funktion Duplicate � wählen,
können Sie noch weitere Parameter wie z.B. die Anzahl der Kopien oder Transformationen an-
geben.
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1 Einführung in moderne Modellierungswerkzeuge 20

1.5.12 Rendern in Maya

Um ein Bild oder auch einen Film einer Szene zu erzeugen, stellen Sie das Pull-Down Menü links
auf der Status Line auf Rendering und wählen Sie dann Menu Bar→Render→Render Current Fra-
me. . . . Der aktive Viewport wird sofort gerendert.

Abbildung 1.23: Rendern und die Render Globals in Maya

In den Render Globals können Sie Einstellungen zum Rendern vornehmen. Sie finden die Ren-
der Globals im geöffneten Render View - Fenster unter Options→Render Globals oder unter Status
Line→Render Globals.

1

2

3

4

5

Abbildung 1.24: Die Render Globals in Maya

1 Render Using - Hier können Sie auswählen, welchen Renderer sie benutzen
wollen (für den Anfang lassen sie die Standardeinstellung).

2 Path - Ausgabepfad (siehe auch Kapitel1.5.2).
3 File Output - Name und Format der Ausgabe.
4 Camera - Hier geben Sie an, welchen Sicht der Szene sie rendern möchten.
5 Resolution - Ausgabegröße in Pixel.
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1.6 Einführung in Rhinoceros / Rhino

Rhino ist ein reines Modellierwerkzeug. Animieren ist nicht möglich, Rendern ist begrenzt mö-
glich. Rhino ist hierbei mehr an Konstruktionswerkzeugen (CAD) orientiert und hat seinen
Schwerpunkt auf der NURBS-Modellierung. Rhino ist nur für Windows verfügbar.

1

2
3

4

6

5

Abbildung 1.25: Die Benutzeroberfläche von Rhino

1 Menu Bar
2 Command Window
3 Docked Toolbar
4 Cascading Toolbar
5 Status Bar
6 Viewports

1.6.1 Besonderheiten von Rhino

Durch das Command Window kann Rhino größtenteils mit Tastatureingaben gesteuert werden.
Teilweise müssen hier Eingaben erfolgen oder Eingaben (auch die, die mit der Maus erfolgt
sind) mit der Enter-Taste bestätigt werden. Zum Abbrechen einer Funktion dient die Esc-
Taste.

Bei Rhino können hinter einem Icon zwei Befehle stecken, die dadurch aufgerufen werden,
indem Sie das Icon mit der linken oder rechten Maustaste anklicken. Die Funktionen der Icons
werden beide angezeigt, sobald sie den Mauszeiger kurz über dem Icon stehen lassen.

Wollen Sie in Rhino ein Objekt auswählen, über oder hinter dem ein anderes Objekt liegt, wird
ein kleines Auswahlfenster angezeigt, in dem das gewünschte Objekt ausgewählt werden
kann.
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1.6.2 Szenen in Rhino

Die Szenen in Rhino unterschieden sich von denen, wie Sie sie von 3ds max und Maya kennen.
Bei Rhino handelt es sich um ein reines Modellierungswerkzeug, was Funktionen wie Animati-
on oder verschiedenartige Lichtquellen, Texturen nicht oder nur sehr begrenzt anbietet. Je nach
Dateiformat, dass Sie beim abspeichern einer Szene wählen, werden Komponenten einer Szene
mit gespeichert oder auch nicht. Die Funktionen Import bzw. Export nutzen Sie nur für einzelne
Objekte aus einer Szene.

1.6.3 Das Command Window von Rhino

Hier können Sie Befehle direkt mit der Tastatur eingeben. Es erscheinen ständig Meldungen, was
Rhino gerade tut oder welche Eingaben es benötigt. Mit der F2-Taste könne Sie hierzu ein eigenes
Fenster öffnen.

1.6.4 Viewports in Rhino

Standardeinstellung beim Start sind vier gleich große Viewports. Die Fenster lassen sich mit der
Maus durch ”Ziehen“ verändern. Jeder Viewport hat in der linken oberen Ecke einen sog. Viewport
Title Bar . Mit einem Doppelklick auf diesen können Sie den jeweiligen Viewport auf vergrößern
uns die anderen Ausblenden. Mit einem Rechtsklick auf die Viewport Title Bar können Sie Ein-
stellungen für den Viewport vornehmen. Um einen Viewport zu aktivieren, klicken Sie einfach
hinein. Der aktive Viewport wird farbig umrandet.

1.6.5 Viewport navigation controls in Rhino

Im Docked Toolbar finden Sie Funktionen um in den einzelnen Viewports zu navigieren. Alle
Veränderungen, die Sie hier tätigen, verändern nur die Sicht in den Viewports und nicht die
einzelnen Objekte!

Abbildung 1.26: Die Viewport Navigation Controls von Rhino

1 Pan – Um die Ansicht zu verschieben.
2 Rotate – Um die Ansicht zu rotieren.
3 Zoom Dynamic – Um in den aktiven Viewport hinein- bzw. hinaus zu zoomen.
4 Zoom Window – Um in eine ausgewählte Region zu vergrößern.
5 Zoom Extents – Um alle Objekte im aktiven Viewport vollständig anzuzeigen.
6 Zoom Selected – Um das ausgewählte Objekt im aktiven Viewport vollständig

anzuzeigen.
7 Undo View Change – Um die letzte Änderung rückgängig zu machen.

1.6.6 Die Maussteuerung von Rhino

Die drei wichtigsten Funktionen zur Navigation in den Viewports lassen sich auch schnell mit der
Maus aufrufen. Hier hängt es jedoch davon ab, in welchem Viewport man sich gerade befindet.

Im Perspective-Viewport:

Rotate – rechte Maustaste

Praktikum Computeranimation und -Visualisierung
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Zoom – Strg-Taste und rechte Maustaste

In allen anderen Viewports:

Pan – rechte Maustaste

Zoom – Strg-Taste und rechte Maustaste

1.6.7 Einfache Objekte erstellen in Rhino

Einfache Objekte finden Sie unter Menu Bar → Solid . Für manche Objekte werden Ihnen verschie-
dene Methoden zur Erzeugung angeboten. Nachdem Sie sich für eine entschieden haben, können
Sie das Objekt dann in einem Viewport mit der Maus erzeugen. Im Command Window werden Sie
jeweils zur Eingabe des jeweiligen Parameters aufgefordert. Beachten Sie, dass dies jeweils mit
der Maus oder auch durch Tastatureingabe in das Command Window geschehen kann.

1.6.8 Objekte auswählen und Parameter verändern in Rhino

Um ein Objekt auszuwählen, aktivieren Sie die Funktion Select und klicken dann auf das gewünsch-
te Objekt. Mit Hilfe der Shift-Taste oder der Strg-Taste können so nacheinander auch mehrere
Objekte ausgewählt werden. Sie können auch ein Auswahlrechteck um mehrere Objekte ziehen.
Weitere Auswahlmöglichkeiten finden Sie unter Menu Bar→Edit→Select .

Die Objektparameter finden Sie unter:

Docked Toolbar→Object Properties

Menu Bar→Edit→Object Properties

F3-Taste

Abbildung 1.27: Select und Object Properties in Rhino

Um ein Objekt zu löschen, wählen Sie es aus und drücken die Entf-Taste.

1.6.9 Transformationen in Rhino

Die drei Transformationen Translation, Rotation und Skalierung führen Sie folgendermaßen durch:

Move - Klicken Sie das Objekt an, halten Sie die linke Maustaste gedrückt und ziehen Sie das
Objekt an Sie gewünschte Position.

Rotate - Klicken Sie auf Menu Bar→ Transform→Rotate. Danach müssen Sie zuerst die Rotati-
onsachse durch zwei Punkte angeben und danach den Winkel.

Scale - Klicken Sie auf Menu Bar→ Transform→Scale. Nachdem Sie eine Skalierung ausgewählt
haben, müssen Sie zuerst die Skalierungsachse durch zwei Punkte angeben und danach den
Skalierungswert.
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Abbildung 1.28: Snaps in Rhinos

1 Snap - Erleichtert das Ausrichten von Objekten am eingestellten Grundraster,
indem es immer bei ganzen Werten ”einrastet“.

2 Ortho - Erleichtert das Ausrichten von Objekten, da es nur Transformationen
zulässt, die parallel oder orthogonal zum jeweiligen Koordinatensystem sind.

3 Planar - Legt fest, dass alle erzeugten Objekte in der gleichen Ebene liegen.
4 Osnap - Steht für Objekt Snap und erleichtert das Ausrichten von Objekten an

anderen Objekten.

1.6.10 Snaps in Rhino

Zum Transformieren von Objekten bietet ihnen Rhino praktische Hilfen, die sog. Snaps an. Diese
können Sie jeweils einzeln an- und ausschalten.

Wie groß das Grundraster (Grid) ist und weitere Einstellungen finden Sie unter
Menu Bar→ File→Properties. . .→Grid .

1.6.11 Objekte spiegeln und kopieren in Rhino

Um ein Objekt zu spiegeln, wählen Sie zunächst das Objekt aus und dann Menu Bar → Transform
→ Mirror . Danach müssen Sie die Spiegelungsachse durch zwei Punkte angeben.

Um ein Objekt zu kopieren, wählen Sie es an und wählen Menu Bar→Transform→Copy .

1.6.12 Rendern in Rhino

Die Funktion, um ein Bild von einer Szene zu erzeugen, finden Sie unter:

Menu Bar→Render→Render

Docked Toolbar→Render

Abbildung 1.29: Rendern in Rhino

Der aktive Viewport wird sofort gerendert. Um die Render-Einstellungen zu verändern, klicken
Sie mit der rechten Maustaste auf das Render-Icon in der Docked Toolbar oder klicken Sie auf Menu
Bar→ Render→Properties. Hier können Sie die Auflösung, den Namen und die Output Directory des
gerenderten Bildes festlegen.
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1.7 Aufgaben

1.7.1 Zur Vorbereitung vor dem Praktikum

Wir erwarten, dass Sie sich mit diesen Unterlagen auf das Praktikum vorbereitet haben, damit
Sie direkt mit dem praktischen Teil anfangen können.

1.7.2 Während des Praktikums

Folgende Aufgaben sollen für jedes Werkzeug nacheinander bearbeitet werden. Bearbeiten Sie
jeweils alle Aufgaben, bevor Sie mit dem nächsten Werkzeug beginnen.

WICHTIG!!! Beachten Sie bitte, dass die Bearbeitung im Praktikum erfolgen muss, vorbereitete
Aufgaben werden nicht anerkannt!

1. Gehen Sie die Einführung zu jedem Werkzeug noch einmal durch und probieren Sie alle ge-
nannten Funktionen praktisch mit dem Werkzeug aus.

2. Erzeugen Sie einen Würfel, einen Zylinder, eine Kugel (Sphere) und einen Torus (jeweils nur
ein Objekt!) und benennen Sie diese sinnvoll. Die Farbgebung ist ihrem Geschmack über-
lassen. Versuchen Sie mit diesen Körpern das unter Abbildung 1.30 abgebildete Objekt zu
modellieren. WICHTIG: Setzten Sie dazu die in der Einführung vorgestellten Funktionen wie
Kopierern und Ausrichten sinnvoll ein!

3. Speichern Sie die erstellten Szenen als

modellierungswerkzeuge-max.max,modellierungswerkzeuge-maya.mbbzw.
modellierungswerkzeuge-rhino.3dm
und jeweils ein gerendertes Bild als
modellierungswerkzeuge-max.jpg,modellierungswerkzeuge-maya.jpgund
modellierungswerkzeuge-rhino.jpg

in Ihrem Home-Verzeichnis auf gauss.

4. Sollten Sie früher mit allen Aufgaben fertig sein, dann nutzen Sie die Zeit, um sich näher mit
den Werkzeugen vertraut zu machen.

Abbildung 1.30: Übungsobjekt
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1.7.3 Abgabe

Erstellen Sie unter

\\gauss\public\cav\Modellierungswerkzeuge\Abgabe

einen Ordner (als Namen nehmen Sie die Nachnamen der Teammitglieder, getrennt durch ein

”&“) und speichern Sie dort die drei von Ihnen erstellten Szenen (nur die Endversion) und Bilder
ab.

1.7.4 Nachbereitung

Nach dem Praktikumstermin sollte Ihnen die grundlegende Bedienung der drei Modellierungs-
werkzeuge klar sein. Es ist zu empfehlen, mit den freien Versionen der Werkzeuge zu Hause
etwas zu experimentieren um noch etwas vertrauter mit der Bedienung der Werkzeuge zu wer-
den.

Zur Nachbereitung beantworten Sie bitte folgende Fragen und geben diese in schriftlicher Form
auf einem DIN A4 Blatt am nächsten Praktikumstermin im VisLab ab. Benutzen Sie hierzu die
Vorlage, den Sie mit diesen Unterlagen erhalten haben.

1. Nennen Sie die Gemeinsamkeiten der drei Modellierungswerkzeuge im Bereich

(a) Bedienung

(b) Oberflächengestaltung

(c) Arbeitsweise.

2. Nennen Sie die Unterschiede der drei Modellierungswerkzeuge, im Bereich

(a) Bedienung

(b) Oberflächengestaltung

(c) Arbeitsweise.
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